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Gracias por adquirir el sistema de purificación de ácidos nucleicos 
MagBinder® Fit24.

Para el uso correcto del instrumento, lea atentamente este manual antes 
de utilizarlo y consérvelo para futuras consultas.

Inspección de apertura

Compruebe el instrumento cuando abra el envase por primera vez. 
Si hay algo que falte o sea incorrecto, póngase en contacto con nosotros 
en info@omegabiotek.com.

Omega Bio-tek
400 Pinnacle Way, Suite 450
Norcross, GA 30071
Teléfono: +1-770-931-8400
Correo electrónico: info@omegabiotek.com
Sitio web: www.omegabiotek.com

Prólogo 

Prólogo 
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Contenido del equipo

Contenido del equipo

Artículo Cantidad

Unidad principal 1

Cable de alimentación 
para la UE 1

Cable de alimentación 
para el Reino Unido 1

Bandeja 1

Soportes de bandeja 2

Ratón 1

Llave Allen, 2,5 mm 1

Llave Allen, 3,0 mm 1

USB 1

Kit de calificación1 1

1El kit de calificación MagBinder® Fit24 se incluye con el equipo comprado; 
sin embargo, el kit se envía por separado.
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Advertencias y directrices de seguridad

Advertencias y directrices de seguridad

1.	 Seguridad general

Lea atentamente este manual del usuario en su totalidad antes de utilizar 
el sistema.

Antes de utilizar el instrumento, revise detenidamente 
este manual del usuario. No leer, comprender y cumplir las 
instrucciones del manual puede provocar daños en el instrumento, 
posibles daños al operador o un funcionamiento insuficiente del 
instrumento.

Atención: peso elevado. Utilizar técnicas de elevación para dos 
personas para mover el equipo.

2.	 Consejos de seguridad

El funcionamiento, el mantenimiento y la reparación del instrumento deben 
cumplir las directrices y precauciones básicas indicadas a continuación. 
Preste especial atención a todas las declaraciones de «Advertencia», 
«Atención» y «Nota», así como a los símbolos y marcas de seguridad que 
se encuentran en el instrumento y en este manual. El uso incorrecto del 
instrumento puede provocar daños en el sistema, resultados inexactos 
o potencialmente anular las garantías.

Este instrumento es un instrumento de mesa que cumple con 
la clase I de la norma IEC 61010-1 y la norma IEC 61326.

Para reducir al mínimo el riesgo de lesiones, contaminación 
biopeligrosa, incendio o descarga eléctrica, siga siempre las 
medidas de seguridad fundamentales y los protocolos de 
seguridad locales cuando utilice este instrumento.

El operador no debe abrir ni reparar el instrumento sin la 
autorización de la empresa. De lo contrario, podrían producirse 
daños en el instrumento, lesiones al profesional, y afectar a la 
garantía.

Antes de encender el instrumento, asegúrese de que el voltaje 
coincida con los requisitos del instrumento y de que la carga 
nominal máxima pueda soportarlo adecuadamente. En caso de 
daños en el cable de alimentación, sustitúyalo por un cable que 
cumpla las mismas especificaciones. 
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Asegúrese de que el cable de alimentación no esté obstruido y de 
que esté colocado lejos de zonas de tráfico elevado mientras esté 
funcionando. Al desconectar el enchufe de la toma de corriente, 
asegúrese de sujetarlo firmemente y evite tirar exclusivamente del 
cable de alimentación.

Las superficies del bloque calefactor pueden alcanzar altas 
temperaturas durante el funcionamiento. Para evitar posibles 
lesiones, no toque estas superficies cuando el instrumento esté 
en uso.

Mantenga el instrumento en un entorno libre de polvo, agua, 
luz solar directa o fuente de luz intensa, cualquier fuente de calor, 
gases corrosivos e interferencias magnéticas intensas. Asegure 
una ventilación adecuada con niveles bajos de humedad. Si utiliza 
varios instrumentos, mantenga una distancia de separación de 
10 cm o más entre ellos.

Para garantizar la fiabilidad óptima del instrumento, es esencial 
seguir diligentemente las instrucciones de mantenimiento 
preventivo. Es posible que un instrumento con mantenimiento 
indebido no ofrezca resultados óptimos.

Asegúrese de apagar el instrumento después de utilizarlo. Si el 
instrumento no se va a utilizar durante largos periodos de tiempo, 
desenchúfelo de la toma de corriente. Cubra el instrumento para 
prevenir la acumulación de polvo.

Desenchufe inmediatamente el instrumento en las siguientes 
situaciones y póngase en contacto con el proveedor:
•	 Fuga de líquido en el instrumento
•	 El instrumento se moja o se quema
•	 El instrumento se comporta de forma anómala, por ejemplo 

sonidos u olores anómalos
•	 El instrumento se ha caído o la cubierta exterior está dañada
•	 El instrumento tiene un funcionamiento defectuoso

Advertencias y directrices de seguridad



vQMF27.0347.MBFIT24CEIVD					     Revisión 1.1

Este instrumento contiene imanes permanentes. Los operadores 
que lleven un marcapasos o prótesis metálicas no deben utilizar 
este instrumento. El contacto cercano con un campo magnético 
puede dañar o afectar al marcapasos o a las prótesis.

Evite colocar la unidad MagBinder® Fit24 cerca de cintas 
magnéticas, medios informáticos u otros dispositivos de 
almacenamiento magnético, ya que el campo magnético 
generado por las varillas del instrumento puede causarles daños. 
Tenga cuidado para evitar dañar accidentalmente los imanes 
durante el proceso de limpieza.

El MagBinder® Fit24 viene equipado con una lámpara UV para 
descontaminar la cámara de proceso. Tenga en cuenta que abrir 
la puerta delantera desactivará automáticamente la lámpara UV.

Indica instrucciones para la eliminación.
NO deseche este instrumento en residuos municipales sin 
clasificar cuando este instrumento haya llegado al final de su vida 
útil. Siga las ordenanzas municipales locales sobre residuos para 
la eliminación adecuada.

Advertencias y directrices de seguridad
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Advertencias y directrices de seguridad

3.	 Mantenimiento preventivo

Para garantizar un funcionamiento diario constante, mantenga el 
instrumento en un entorno libre de polvo y derrames de líquidos. Evite 
el uso de productos de limpieza abrasivos, ya que son propensos a causar 
daños al instrumento. 

Cuando sea necesario, limpie las superficies externas o las cubiertas del 
instrumento con un paño humedecido con agua o un detergente suave. 
Limpie las varillas magnéticas con un paño suave o una toallita desechable 
empapada en una solución de detergente suave, una solución de jabón 
o alcohol cuando sea necesario. Siga las recomendaciones del fabricante 
para diluir el producto de limpieza.

Retire rápidamente las soluciones salinas, disolventes, ácidos o soluciones 
alcalinas derramadas sobre las superficies externas. La exposición 
prolongada a estas soluciones puede causar daños. Si alguna superficie se 
contamina con material biopeligroso, aplique una solución descontaminante 
suave, como se ha mencionado anteriormente, a la zona afectada.

No utilice ningún agente de limpieza que contenga lejía, ya que puede 
reaccionar con agentes caotrópicos a base de guanidina y formar un 
compuesto altamente reactivo.
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4.	 Directrices de transporte y almacenamiento

Intervalo de temperatura ambiente: 10 °C – 35 °C
Humedad relativa: ≤70 %
Intervalo atmosférico: 500 – 1060 hPa
Zona bien ventilada sin exposición a gas corrosivo

5.	 Garantía y servicio

5.1	 Contenido

Omega Bio-tek sustituirá el instrumento por motivo de defectos en los 
materiales y en la fabricación descubiertos en el plazo de un mes desde la 
fecha de entrega. El período de garantía es de 12 meses a partir de la fecha de 
entrega por cualquier fallo del instrumento causado por defectos de materiales 
y de fabricación. Durante este período de garantía, Omega Bio-tek reparará o 
sustituirá el instrumento si se demuestra que está defectuoso, según la gravedad 
del problema.

El usuario enviará los productos en garantía al departamento de mantenimiento 
designado por Omega Bio-tek. El usuario pagará el transporte y la entrega del 
instrumento a la empresa, y esta pagará la devolución.

Para obtener más información sobre las garantías o servicios ampliados, póngase 
en contacto con info@omegabiotek.com. 

5.2	 Cobertura

La garantía anterior no es aplicable a los daños causados por un uso 
y mantenimiento indebidos por parte del usuario, el uso de prácticas 
de no conformes por parte del usuario, el mantenimiento no autorizado 
o la modificación del instrumento.

Advertencias y directrices de seguridad
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Capítulo 1 Introducción

Capítulo 1 Introducción

El sistema de purificación de ácidos nucleicos MagBinder® Fit24 utiliza varillas 
magnéticas al unísono para adsorber, transferir y liberar partículas magnéticas 
en los pocillos de los cartuchos de reactivos para la purificación de ADN y ARN. 
El instrumento puede alojar de 1 a 24 muestras simultáneamente con el uso de 
kits de extracción de ácidos nucleicos basados en microesferas magnéticas de 
diversos tipos de muestras.

1.1	 Uso previsto

El MagBinder® Fit24 es un instrumento de procesamiento de microesferas 
magnéticas diseñado para la automatización de flujos de trabajo de laboratorio, 
incluida la purificación de ácidos nucleicos para uso diagnóstico in vitro 
posterior.

El MagBinder® Fit24 está indicado para uso profesional en un entorno 
de laboratorio. 

El MagBinder® Fit24 viene con protocolos preinstalados diseñados para 
funcionar con los kits Omega Bio-tek. Consulte los kits específicos para obtener 
instrucciones sobre cómo ejecutar los protocolos preinstalados. Si tiene alguna 
pregunta sobre los protocolos del instrumento, póngase en contacto con 
Omega Bio-tek en info@omegabiotek.com.  

Tenga en cuenta que el usuario es responsable de verificar las características 
de funcionamiento de cualquier procedimiento no cubierto por los estudios 
de evaluación del funcionamiento de Omega Bio-tek. El usuario también es 
responsable de establecer las métricas de funcionamiento necesarias para la 
aplicación de diagnóstico posterior de su elección.

1.2	 Garantía de fabricación

La garantía de fabricación del instrumento es de 12 meses a partir de la fecha 
de envío.

Para obtener más información sobre las garantías o servicios ampliados, 
póngase en contacto con info@omegabiotek.com.
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1.3	 Características

•	 Interfaz de pantalla táctil fácil de usar
•	 3 teclas de acceso directo y/o funcionamiento del ratón
•	 Función de calentamiento disponible
•	 Luz UV para la descontaminación del instrumento
•	 Funcionamiento silencioso con vibración mínima
•	 Interacción mínima una vez que las muestras se estén procesando 

en el instrumento

Capítulo 1 Introducción
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2.1	 Directrices de funcionamiento normal

Temperatura ambiente: 10 °C – 35 °C
Humedad relativa: ≤70 %
Entrada: CA 100 – 240 V, 50 Hz/60 Hz

2.2	 Parámetros básicos y funcionamiento

Tabla 1 Parámetros básicos y funcionamiento

Parámetro Modelo: MagBinder® Fit24

Principio Procesamiento basado en microesferas magnéticas

Rendimiento 1 – 24 muestras

Materiales plásticos Cartuchos de reactivos de 5 ml o 10 ml + tubo de elución 
de 2 ml

Volumen de muestra (μl) 50 μl – 10.000 μl

Bloque calefactor Temperatura ambiente hasta 100 °C

Precisión de la 
temperatura ±1 °C

Seguridad eléctrica

Cumple los siguientes requisitos:
EN IEC 61326-1
EN IEC 61326-2-6
EN IEC 61010-1
EN IEC 61010-2-101

Interfaz de 
funcionamiento

Pantalla táctil de 7 pulgadas, 3 teclas de acceso directo y ratón 
disponible

Memoria interna Hasta 8 protocolos en la pantalla de acceso directo con 
la capacidad de almacenar hasta 100 protocolos

Importación de 
protocolos USB estándar

Gestión de protocolos Posibilidad de crear protocolos nuevos, editarlos, eliminarlos 
o guardarlos

Descontaminación Luz UV

Salida Ventilador interno

Potencia de entrada 
máxima 450 W

Dimensiones (anchura 
x profundidad x altura) 400 mm x 530 mm x 480 mm

Peso (kg) 34 kg

Capítulo 2 Especificaciones

Capítulo 2 Especificaciones
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2.3	 Dimensiones generales

Apartado 2 Especificaciones

Dimensiones (anchura x profundidad x altura)

MagBinder® Fit24: 400 mm x 530 mm x 480 mm

profundidad

altura

anchura
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Esta sección trata únicamente sobre el esquema del instrumento y la ubicación 
de las características críticas del instrumento.

3.1	 Estructura

3.1.1	 Parte delantera

3.1.2	 Parte trasera

Sección 3 Esquema del producto

Pantalla

Tecla de acceso directo

Ventana de  
funcionamiento

Puerto USB

Puerto Ethernet

Puerto de PC

 
Socket 
 

Fuse 

Power Switch 
 

Fan Ventilador

Interruptor de 
alimentación

Fusible

Enchufe

Capítulo 3 Esquema del producto
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3.1.3	 Vista interior de MagBinder® Fit24

3.2	 Panel de funcionamiento

Pantalla de visualización: Funciona con pantalla táctil o conectando el ratón 
al puerto USB delantero

TAB (TABULADOR): Seleccionar para el protocolo de acceso directo

RUN (EJECUTAR): Seleccionar para iniciar el protocolo de acceso directo

STOP (DETENER): Interrumpir operaciones

Capítulo 3 Esquema del producto

Brazo magnético
(por encima del soporte del peine de puntas)

Ranura de montaje del 
peine de puntas

Bloque calefactor

Plataforma

Luz UV  
(parte interior superior)

Ventilador  
(parte interior inferior)

Pantalla de visualización

TAB (TABULADOR)

RUN (EJECUTAR)

STOP (DETENER)
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Capítulo 4 Instalación

4.1	 Antes de desembalar el instrumento

La unidad MagBinder® Fit24 debe instalarse sobre una superficie estable y 
nivelada que pueda soportar el peso (34 kg) y las dimensiones (400 mm x 
530 mm x 480 mm) del instrumento. Asegúrese de que la zona de trabajo 
específica esté limpia, despejada y libre de obstrucciones que puedan interferir 
con el funcionamiento del instrumento.

Se proporcionan herramientas con el instrumento para liberar la puerta, la 
plataforma deslizante y los brazos magnéticos antes de encender el instrumento. 
Compruebe y confirme el voltaje correcto del instrumento antes de enchufarlo. 
El instrumento debe conectarse a un circuito eléctrico específico capaz de 
suministrar alimentación de 100 – 240 V CA, 50/60 Hz con un mínimo de 5 A.

El lugar de instalación debe estar bien ventilado para garantizar una circulación 
de aire adecuada alrededor del instrumento. Asegúrese de que la temperatura 
y la humedad del lugar de instalación estén dentro de los intervalos 
recomendados: temperatura ambiente entre 10 °C y 35 °C y humedad relativa 
≤70 %. La temperatura ambiente del lugar de instalación debe mantenerse entre 
10 °C y 35 °C (entre 50 °F y 95 °F) para garantizar el funcionamiento óptimo del 
instrumento. La humedad relativa del lugar de instalación debe mantenerse 
a ≤70 %. Si es necesario, utilice un sensor de temperatura y humedad para 
supervisar estas condiciones.

Capítulo 4 Instalación
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Capítulo 4 Instalación

4.2	 Desembalaje del instrumento

Extraiga con cuidado el instrumento de su embalaje y colóquelo sobre una 
superficie estable y nivelada. El MagBinder® Fit24 pesa aproximadamente 34 kg 
y se recomienda que dos personas levanten el instrumento conjuntamente. 
Asegúrese de que estén presentes todos los componentes (consulte «Contenido 
del equipo» en la página ii). Retire la cinta que mantiene la puerta cerrada. Abra 
la puerta del instrumento y retire la espuma para deslizar la plataforma hacia 
afuera (Figura 1). Usando la llave Allen de 3 mm incluida, retire los tornillos y 
extraiga el soporte rojo que está atornillado a la plataforma (vea la flecha roja, 
Figura 2) para liberar el brazo magnético.

Nota: Tenga cuidado al desembalar para evitar dañar las varillas magnéticas.

Figura 1

Figura 2
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4.3	 Colocación de los soportes de la bandeja

Deslice hacia fuera la plataforma y coloque los soportes de la bandeja como 
se muestra en la Figura 3. Coloque el soporte numerado  en el lado izquierdo 
y el número  en el lado derecho de la plataforma.

Capítulo 4 Instalación

4.4	 Conexión de la alimentación

Conecte un extremo del cable de alimentación a la toma del instrumento 
y el otro a la toma de corriente (CA 100 – 240 V). Encienda el interruptor de 
alimentación situado en la parte posterior del instrumento.

4.5	 Ejecución del kit de calificación MagBinder® Fit24

El kit de calificación MagBinder® Fit24 (que se envía por separado) se utiliza para 
asegurarse de que el instrumento funciona correctamente. Abra el kit y siga las 
instrucciones indicadas en el protocolo.

Figura 3

Plataforma
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Capítulo 4 Instalación

4.6	 Preparación de los reactivos

Coloque los cartuchos de reactivos y los tubos de elución en la bandeja en las 
posiciones correspondientes (Figura 4). Asegúrese de que los tubos de elución 
estén abiertos, con las tapas orientadas hacia la derecha del tubo y presionadas 
hacia abajo como se muestra en la Figura 4. Abra la puerta, deslice la plataforma 
hacia fuera y coloque la bandeja sobre la plataforma. Presione firmemente los 
cartuchos y los tubos de elución para asegurarse de que encajen bien en el 
bloque calefactor de la plataforma (Figura 5). Deslice lentamente la plataforma 
al interior del instrumento.

Figura 5

Figura 4

Tubo de 
elución Tubo de 

elución

Bandeja
Cartucho 

de 
reactivos

Bandeja

Soporte 
de 

bandeja

Plataforma
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4.7	 Inserción/retirada de los peines de puntas

Inserte el peine de puntas empujándolo por completo en las ranuras de montaje 
situadas en la parte superior del brazo magnético. Empuje el peine de puntas 
completamente hacia el fondo, de forma que quede fijado (vea las flechas rojas, 
Figura 6).

Retire los peines de la punta tirando de ellos hacia fuera de la ranura de montaje. 
Deseche los peines de puntas en el recipiente de residuos adecuado.

Capítulo 4 Instalación

Figura 6

Ranura de 
montaje

Peine de 
puntas
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5.1	 Interfaz de inicio

Antes de empezar, asegúrese de que la puerta esté cerrada. Encienda 
el instrumento para mostrar la interfaz de arranque.

Capítulo 5 Funcionamiento

Capítulo 5 Funcionamiento

Una vez que el instrumento esté listo, la pantalla cambiará a la pantalla Shortcut 
(Acceso directo) que se muestra a continuación.
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Capítulo 5 Funcionamiento

5.2	 Ejecutar programa

5.2.1 Acceso directo

En la pantalla de «Shortcut» (Acceso directo) (en la imagen de la página 
anterior), seleccione el programa deseado y pulse «Run» (Ejecutar) en 
el lado derecho. Esto llevará a la interfaz de ejecución del programa.

El programa también se puede seleccionar pulsando el botón «Tab» 
(Tabulación) del panel y, a continuación, pulsando «Run» (Ejecutar) 
para iniciar o «Stop» (Detener) para interrumpir el proceso.

En la figura anterior, la información sobre paso del protocolo actual 
se muestra en el lado izquierdo de la pantalla. El pocillo resaltado indica 
la posición actual en el programa. 

La posición y la temperatura del bloque calefactor también se muestran 
en la pantalla. 

En la parte inferior de la pantalla se encuentra la barra de progreso. 
El tiempo restante para el programa se muestra en la esquina superior 
derecha.
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Capítulo 5 Funcionamiento

5.2.2   Pausa o detención del programa

Para detener un programa, seleccione «Stop» (Detener) durante el 
procesamiento. Seleccione «Cancel» (Cancelar) para que el programa 
siga ejecutándose. Seleccione «Confirm» (Confirmar) y el programa 
se detendrá y devolverá al usuario a la pantalla de inicio. Para volver a 
iniciar el mismo programa después de detenerlo, seleccione «Rerun» 
(Volver a ejecutar) y el programa se reanudará desde el principio.

Para pausar un programa durante la ejecución, seleccione «Pause» 
(Pausa) durante la ejecución. Para reanudar el programa, seleccione 
«Continue» (Continuar).

Seleccione «Back» (Atrás) para volver a la pantalla anterior.

Importante: Si la puerta está abierta durante el procesamiento, 
aparecerá en la pantalla el mensaje que se muestra a continuación. 
Una vez cerrada la puerta, el instrumento seguirá funcionando.
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Capítulo 5 Funcionamiento

5.2.3   Modo de lista

Los usuarios pueden ver todos los programas utilizando la barra 
de desplazamiento de la derecha. Seleccione el programa deseado 
de la lista. Pulse «Run» (Ejecutar) para ir a la pantalla principal e iniciar 
el programa. 

Seleccione «View» (Ver) para ver los pasos y parámetros del programa. 
En esta pantalla, seleccione «Option» (Opción) en un paso de sección 
para ver los parámetros de cada paso. No se pueden realizar cambios 
en esta pantalla.

Seleccione «Back» (Atrás) para volver a la pantalla anterior.
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5.2.4   Lámpara

En la esquina inferior derecha de la pantalla, el icono «  » indica que 
la lámpara está encendida. El icono «  » indica que la lámpara está 
apagada. Seleccione este icono para encender o apagar la lámpara 
del instrumento.

5.3	 Gestión de programas

Seleccione «Manage Prog.» (Gestionar programas) para acceder a la pantalla 
de gestión de programas.

5.3.1   Acceso directo

Seleccione «» en la columna Shortcut (Acceso directo) para mostrar 
el protocolo en el menú de Shortcut (Acceso directo). 

Un protocolo con el icono de bloqueo « » indica que no se puede 
editar, eliminar ni guardar. No se pueden realizar modificaciones. Un 
protocolo con el icono de desbloqueo « » indica que se puede editar, 
eliminar y guardar.
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5.3.2   Crear nuevo protocolo

Seleccione «New - 5 mL» (Nuevo - 5 ml) o «New - 10 mL» (Nuevo - 10 ml) 
en el lado derecho de la pantalla Manage prog. (Gestionar programas) 
para crear un nuevo protocolo basado en el tamaño del cartucho de 
reactivos. Cree un nombre para el nuevo protocolo y pulse «Enter» 
(Entrar).

Seleccione «Insert» (Insertar) para añadir un nuevo paso al protocolo.

Seleccione «  » a la derecha para mostrar ajustes de parámetros 
adicionales.
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Seleccione «  » para volver a los parámetros de la pantalla anterior.

Cada parámetro y su función se muestran en la tabla siguiente. Tenga en 
cuenta que algunos parámetros están desactivados dependiendo de las 
condiciones de la etapa.

Parámetros y función del paso
Parámetro Descripción Función Notas

Well 
(Pocillo)

Número de pocillo o 
posición del cartucho 
de reactivos.

Posición en la que 
comienza el paso en 
el protocolo.  

Determinadas opciones 
están desactivadas 
dependiendo de la posición 
del pocillo seleccionada.

Inserte una pausa 
para permitir que el 
usuario interactúe 
con el instrumento 
durante el 
procesamiento.

Introduzca «0» o «9» para 
añadir un paso de pausa 
en el protocolo. 

La varilla magnética estará 
por encima del cartucho 
de reactivo. Todas las 
demás opciones están 
desactivadas.

Introduzca «0» para pausar 
con la varilla magnética fuera 
del peine de puntas.

Introduzca «9» para pausar 
con la varilla magnética 
dentro del peine de puntas.

Name 
(Nombre) Nombre del paso

El nombre del paso 
aparecerá en un mensaje 
en una ventana emergente 
durante la ejecución del 
protocolo

El nombre debe tener 
≤9 caracteres.

Mix Time 
(Tiempo 
de mezcla) 
(min)

Cuánto tiempo hay 
que mezclar

Cantidad de tiempo 
para mezclar el pocillo 
seleccionado

Introduzca valores entre 
0,0 y 99,0.

Magnet  
(sec) (Imán 
(s))

Cuánto tiempo 
se magnetiza

Cantidad de tiempo para 
magnetizar las partículas 
magnéticas

Introduzca valores entre 
0 y 999.
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Wait Time 
(Tiempo 
de espera) 
(min)

Cuánto tiempo 
esperar tras la 
recogida de 
partículas

Tiempo de espera antes de 
iniciar el siguiente paso

Introduzca valores entre 
0,0 y 99,0.

Volume (μl) 
(Volumen 
(μl))

Volumen total en el 
pocillo del cartucho 
de reactivos

El volumen total se 
utiliza para determinar 
las opciones «Mix Pos» 
(Posición mezcla), «Mix 
Amp» (Amplitud de 
mezcla), y «Mag Pos» 
(Posición imán).

El instrumento establecerá 
de forma predeterminada 
el volumen máximo si el 
volumen introducido es 
demasiado elevado para 
la posición de pocillo 
seleccionada.

Tira de 10 ml: Volumen 
máximo del primer pocillo, 
10.000 μl. Todos los demás 
pocillos hasta 1000 μl.

Tira de 5 ml: Volumen 
máximo del primer pocillo, 
5000 μl. Todos los demás 
pocillos hasta 1000 μl.

Mix Speed 
(Velocidad 
de mezcla) 
(1 – 10)

Velocidad de 
mezclado

Introduzca «1» para la 
velocidad más lenta y «10» 
para la velocidad más 
rápida.

El tiempo de mezcla debe 
ser ≥1 minuto

Temp  
(Tempera-
tura) (°C)

Temperatura del 
bloque calefactor

Establezca la temperatura 
de los 4 bloques 
calefactores de la 
plataforma. 

Introduzca <37 °C para 
no calentar durante el 
paso. Introduzca >37 °C 
para calentar hasta la 
temperatura establecida.

Solo aplicable en las 
siguientes situaciones:

Cartucho de reactivos de 
10 ml: posiciones de los 
pocillos 1 y 6.

Cartucho de reactivos de 
5 ml: posiciones de los 
pocillos 1 y 8.

Mix Pos 
(Posición 
mezcla)  
(0 – 100 %)

Posición de la varilla 
magnética dentro 
del pocillo durante 
el paso de mezclado

El instrumento calcula 
la posición dentro del 
pocillo de acuerdo con el 
volumen total del pocillo.

Introduzca «0» para el fondo 
del pocillo o «100» para la 
superficie del líquido. El 
tiempo de mezcla debe 
ser ≥1 minuto.

Mix Amp 
(Amplitud 
mezcla) 
(0 – 100 %)

Posición de altura de 
la varilla magnética 
durante el paso de 
mezclado

El instrumento calcula 
la posición dentro del 
pocillo de acuerdo con el 
volumen total del pocillo.

Introduzca «0» para la 
menor amplitud de la varilla 
magnética o «100» para la 
mayor.

Esta opción está desactivada 
en la posición del pocillo 1.

Mag Pos 
(Posición 
imán) 
(0 – 100 %)

Ubicación de la varilla 
magnética dentro del 
pocillo

El instrumento calcula 
la posición dentro del 
pocillo de acuerdo con el 
volumen total del pocillo.

El tiempo del imán debe ser 
≥1 segundo.

Mag Speed 
(Velocidad 
de magne-
tización) 
(1 – 10)

Velocidad de 
magnetización 
durante la recogida 
de partículas

Introduzca «1» para la 
velocidad más lenta y «10» 
para la velocidad más 
rápida.

El tiempo del imán debe ser 
≥1 segundo.

Seleccione «Option» (Opción) para ir a una nueva pantalla, que permite 
al usuario definir otro conjunto de parámetros para la etapa actual 
seleccionada. La siguiente tabla describe los parámetros y sus funciones 
en el menú «Option» (Opción).

Capítulo 5 Funcionamiento
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Parámetros y función de la opción
Parámetro Descripción Función Notas

Heat Block 
(Bloque 
calefactor)

Seleccionar 
un módulo de 
temperatura para 
encenderlo/apagarlo

Activar o desactivar 
bloques calefactores 
especificados durante 
el funcionamiento

Esta opción se desactiva 
automáticamente cuando 
hay otros pocillos aparte de la 
primera o última posición en 
la configuración de cartucho 
seleccionada.

Heat Setup 
(Configu-
ración de 
calefacción)

Calentar cuando 
se inicie el paso

El bloque calefactor 
empieza a calentarse 
en el paso designado

El tiempo asociado con el 
paso de calefactor comienza 
cuando comienza el paso y 
termina cuando termina el 
tiempo.

Precalentamiento: 
el tiempo comienza 
a la temperatura 
establecida

El procesamiento no 
comienza hasta que el 
bloque calefactor alcanza 
la temperatura establecida 
antes de iniciar el paso

El tiempo asociado con el 
paso de calefactor comienza 
cuando se alcanza la 
temperatura establecida.

Iniciar cuando 
X °C por debajo 
de la temperatura 
establecida

El paso comienza cuando 
el bloque calefactor 
alcanza X °C por debajo de 
la temperatura establecida

El bloque calefactor se 
calienta a una temperatura 
inferior antes de la 
temperatura establecida

Empezar a calentar 
con X pasos de 
antelación

El bloque calefactor 
comienza a calentarse 
hasta 3 pasos antes del 
paso actual

Sólo funciona para la última 
posición del pocillo.

Cool Setup 
(Configu
ración de  
enfria-
miento)

Enfriar cuando 
comience el paso

El bloque calefactor 
comienza a enfriarse 
en el paso designado

El tiempo asociado con 
el paso de enfriamiento 
comienza cuando comienza 
el paso y termina cuando 
termina el tiempo.

Preenfriamiento: el 
tiempo comienza 
a la temperatura 
establecida

El procesamiento se 
detiene brevemente 
cuando el bloque 
calefactor alcanza la 
temperatura establecida 
antes de iniciar el paso

El tiempo asociado con 
el paso de enfriamiento 
comienza cuando se alcanza 
la temperatura establecida.

Empiezar a enfriar 
cuando esté X °C 
por encima de 
la temperatura 
establecida

El bloque calefactor 
comienza a enfriarse a la 
temperatura establecida

El bloque calefactor se enfría 
a una temperatura más alta 
antes de la temperatura 
establecida.

Opción de ventilador
Encender o apagar el 
ventilador durante el 
proceso de enfriamiento

El ventilador puede estar 
encendido o apagado 
mientras se enfría el bloque 
calefactor o la muestra.

Capítulo 5 Funcionamiento
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Magnet 
Setup  
(Configu-
ración del 
imán)

La magnetización 
comienza cuando las 
varillas magnéticas 
están en posición

Las varillas magnéticas se 
mueven a la posición de 
ajuste y se fijan durante 
el proceso de recogida

Esta opción depende del 
parámetro «Mag Pos» 
(Posición del imán) del paso.

Reciprocar varillas 
magnéticas

Las varillas magnéticas 
se mueven hacia arriba 
y hacia abajo durante 
el proceso de recogida

Esta opción depende del 
parámetro «Mag Pos» 
(Posición del imán) del paso.

Magnetización por 
pasos

Las varillas magnéticas 
recogen partículas en 
pasos, dependiendo de 
las secciones designadas

Las partículas se recogen a 
intervalos diferentes dentro 
del líquido.

Dry Setup 
(Configu-
ración en 
seco)

Por encima de la tira 
reactiva

El peine de puntas 
se elevará fuera de los 
pocillos del cartucho 
de reactivos

El secado tiene lugar fuera 
o por encima del cartucho 
de reactivos.

Por encima del nivel 
de líquido X mm

Designar que distancia se 
elevará el peine de puntas 
por encima del nivel de 
líquido

El secado se produce dentro 
del pocillo, por encima del 
nivel de líquido.

Opción de ventilador
Encender o apagar 
el ventilador durante 
el proceso de secado

El ventilador puede estar 
encendido o apagado 
mientras se secan las 
partículas magnéticas.

Para añadir un paso:

Seleccione «Insert» (Insertar) para añadir un paso por encima del paso 
resaltado. 

Para eliminar un paso:

Seleccione «Delete» (Eliminar) para abrir un aviso y proceder a eliminar 
el paso resaltado. Seleccione «Confirm» (Confirmar) para eliminar el paso 
y volver a la pantalla. Seleccione «Cancel» (Cancelar) para conservar el 
paso y volver a la pantalla.

Para guardar un programa:

Seleccione «Save» (Guardar) para abrir un aviso y proceder a guardar 
los cambios nuevos realizados en el protocolo. Seleccione «Confirm» 
(Confirmar) para aceptar los cambios y guardar el protocolo. Seleccione 
«Cancel» (Cancelar) para volver a la pantalla sin guardar los cambios.

Capítulo 5 Funcionamiento
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Para navegar a la pantalla anterior: 

Seleccione «Back» (Atrás) para abrir un aviso y proceder a guardar 
los nuevos cambios si aún no los ha guardado. Seleccione «Confirm» 
(Confirmar) para guardar los cambios y volver a la pantalla Manage Prog. 
(Gestionar programas). Seleccione «Cancel» (Cancelar) para volver a la 
pantalla Manage Prog. (Gestionar programas) sin guardar los cambios.

5.3.3   Editar el protocolo existente

En la pantalla de inicio «Manage Prog.» (Gestionar programas), resalte 
el protocolo elegido y seleccione «Edit» (Editar) en el lado derecho 
del panel. En la pantalla siguiente, resalte el paso que desea editar. 
Esto llevará a la misma pantalla que se menciona en el apartado 5.3.2 
«Crear nuevo protocolo». Consulte la sección 5.3.2 para obtener más 
información.

5.3.4   Gestión de programas 

Seleccione «Save As» (Guardar como) en el protocolo resaltado para 
crear un nuevo nombre para el protocolo actual, utilizando los mismos 
parámetros de paso. Una ventana aparecerá permitiendo al usuario 
crear un nuevo nombre.

Seleccione «New - 5mL» (Nuevo - 5 ml) o «New - 10mL» (Nuevo - 10 ml) 
para crear un nuevo protocolo según el tamaño del cartucho de 
reactivos. Consulte la sección 5.3.2 para obtener más información.

Seleccione «Edit» (Editar) en el protocolo resaltado para realizar nuevos 
cambios en los pasos y/o parámetros dentro del protocolo. Consulte 
la sección 5.3.3 para obtener más información.

Seleccione «Delete» (Eliminar) sobre el protocolo resaltado para abrir 
un aviso y proceder a eliminarlo. Seleccione «Confirm» (Confirmar) para 
eliminar el protocolo. Seleccione «Cancel» (Cancelar) para cancelar y 
volver a la pantalla.
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5.4.1   Instrumento 

Los parámetros del instrumento se definen en la sección «Instrument» 
(Instrumento). Después de seleccionar «Instrument» (Instrumento), 
se pedirá al usuario que introduzca la contraseña del administrador. 
El acceso a la configuración del «Instrument» (Instrumento) está 
restringido por el proveedor y se utilizará en casos en los que el 
instrumento haya fracasado en un procesamiento o necesite repararse. 
Póngase en contacto con Omega Bio-tek en info@omegabiotek.com 
para obtener más información.

5.4	 Configuración del sistema

Seleccione «Settings» (Configuración) en la parte superior para acceder 
al menú System Settings (Configuración del sistema).

Capítulo 5 Funcionamiento
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5.4.2   Fecha y hora
 

Seleccione «Date & Time» (Fecha y hora) para establecer la fecha y la hora 
del instrumento. La configuración se puede ajustar utilizando el signo 
«+» o «–» en la pantalla táctil o cambiando directamente los números.

5.4.3   Idioma
 

Seleccione «Language» (Idioma) para establecer el idioma 
del instrumento.
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5.4.4   Salida
 

Seleccione «Air Ejector Fan» (Ventilador de la salida de aire) para ajustar 
la configuración del ventilador.

Capítulo 5 Funcionamiento

5.4.5   Importar y exportar

Seleccione «Im. & Export» (Importar y exportar) para transferir datos 
hacia y desde el instrumento. La unidad flash suministrada con el 
instrumento contiene una carpeta «Items» (Elementos) designada para 
transferir datos. Inserte la unidad flash en el puerto USB y seleccione 
«Import» (Importar) o «Export» (Exportar) en el menú para ejecutarla.
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5.4.6   Actualización del programa informático

Póngase en contacto con Omega Bio-tek en info@omegabiotek.com 
para obtener actualizaciones.

5.5	 Descontaminación UV

Seleccione «UV Sterilizer» (Esterilizador UV) en la parte superior para 
establecer el tiempo de esterilización del instrumento. La configuración 
se puede ajustar utilizando el signo «+» o «–» en la pantalla táctil o 
cambiando directamente los números.

Seleccione «Start» (Iniciar) para comenzar la descontaminación. 
Seleccione «Stop» (Detener) para finalizar la descontaminación.

Capítulo 5 Funcionamiento
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Durante la descontaminación, si se abre la puerta, la luz UV se apagará 
automáticamente. Cierre la puerta para reanudar la descontaminación.

Importante: El tratamiento UV no debe sustituir al proceso de limpieza. 
Depender únicamente del tratamiento UV puede no asegurar una 
descontaminación completa. Consulte la sección «Mantenimiento 
preventivo» para obtener más detalles.

5.6	 Ayuda

Seleccione «Help» (Ayuda) en la parte superior para obtener más 
información sobre las funciones y la versión del instrumento 
correspondientes. El usuario puede elegir qué configuración ver en el 
lado izquierdo del menú.

5.7	 Salir del programa/apagar el instrumento

En la parte posterior del instrumento, apague el interruptor 
de alimentación para salir del programa informático y apagar 
el instrumento.
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Capítulo 6 Solución de problemas

Utilice esta guía para solucionar los problemas que puedan surgir.

Problema Posible causa Solución

La pantalla no funciona 
correctamente cuando 
el instrumento está 
encendido

La alimentación no está 
conectada

Compruebe que el cable 
de alimentación esté 
enchufado a la toma 
de corriente.

Fallo del interruptor
Cambie el interruptor. 
Póngase en contacto 
con Omega Bio-tek.

Fallo del fusible Sustituya el fusible 
(5X20 250 V 8 A).

Otros problemas Póngase en contacto 
con Omega Bio-tek.

Sin luz UV Fallo de la luz UV
Sustituya la lámpara. 
Póngase en contacto 
con Omega Bio-tek.

Sin luz Fallo de luz
Sustituya la lámpara. 
Póngase en contacto 
con Omega Bio-tek.

El instrumento no se 
detiene cuando la puerta 
está abierta

Fallo del sensor Póngase en contacto 
con Omega Bio-tek.

La diferencia entre la 
temperatura real y la 
temperatura mostrada 
es mayor de lo esperado

Fallo del sensor Póngase en contacto 
con Omega Bio-tek.

El bloque calefactor no se 
calienta correctamente

Fallo del sensor
Póngase en contacto 
con Omega Bio-tek.Fallo del SCR

Fallo del bloque calefactor

El instrumento no arranca 
correctamente

Fallo del controlador Póngase en contacto 
con Omega Bio-tek.Fallo del motor

Sonido anormal durante 
el funcionamiento

Riel de guía instalado 
incorrectamente

Póngase en contacto 
con Omega Bio-tek.Fallo del motor

Abrasión del cinturón 
síncrono

El funcionamiento de los 
botones no es correcto Fallo del botón Póngase en contacto 

con Omega Bio-tek.
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Tipo de problema Nombre del problema Mensaje de error

Temperatura (Código: 0)

T1, T2, T3, T4 
sobrecalentamiento E011, E021, E031, E041

T1, T2, T3, T4 
fallo del circuito controlador E018, E028, E038, E048

T1, T2, T3, T4 
circuito abierto E015, E025, E035, E045

T1, T2, T3, T4 
cortocircuito E016, E026, E036, E046

Fallo del circuito controlador 
del ventilador de salida E019

Fallo del circuito controlador 
del ventilador de enfriamiento E009

Maquinaria eléctrica 
(Código: 1)

Fallo del bloqueo del freno 
de la maquinaria eléctrica E108

Posición de 
accionamiento de la 
maquinaria eléctrica 

(Código: 4)

Problema del sensor izquierdo E403

Fallo de posición de 
la cubierta de la varilla 
magnética en la maquinaria 
eléctrica

E425

Fallo de posición de la varilla 
magnética en la maquinaria 
eléctrica

E415

LCD, oscilador de 
cristal, almacenamiento 

(Código: 7)

Fallo de cristal del reloj E702

Fallo E2P del chip de 
almacenamiento, parámetro 
de configuración perdido

E703

Comunicación 
(Código: 8) Fallo en línea E801

Capítulo 6 Solución de problemas
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7.1	 Abreviaturas

Abreviatura Definición

A Amperio

CA Corriente alterna

V Voltaje

Hz Hercios

W Vatios

USB Bus universal en serie

Wi-Fi WLAN

kg Kilogramo

mm Milímetro

μl Microlitro

hPa Hectopascales

°C Grado centígrado

CV Coeficiente de variación del pocillo

TAB (TABULADOR) Alternar la selección

RUN (EJECUTAR) Iniciar operación

STOP (DETENER) Detener operación

Capítulo 7 Abreviaturas y símbolos
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7.2	 Símbolos

Símbolo Descripción

Atención

Superficie caliente

Riesgo biológico

Campo magnético

Radiación ultravioleta

Entrada eléctrica

Fabricante

Fecha del fabricante

Representante autorizado en la UE

Representante autorizado en Suiza

Consulte las instrucciones de uso o las 
instrucciones de uso electrónicas

Marcado de certificación

Número de catálogo
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Número de serie

Producto sanitario para diagnóstico 
in vitro

Identificador único del producto

Cumplimiento de RoHS

Símbolo WEEE. El producto debe enviarse 
a centros de recogida independientes 
para su recuperación y reciclaje

Sitio web

Teléfono

Fax

Correo electrónico

LinkedIn

Twitter

Facebook

Capítulo 7 Abreviaturas y símbolos
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Información de contacto

Para volver a pedir suministros, notificar un fallo del producto o hacer una 
reclamación, póngase en contacto con:

Fabricante
Omega Bio-tek, Inc.
400 Pinnacle Way
Suite #450
Norcross, GA 30071, EE.UU.
Sitio web: www.omegabiotek.com
Correo electrónico: info@omegabiotek.com
SRN: US-MF-000024148

Representante autorizado europeo
Qarad EC-REP BV
Pas 257
2440 Geel, Bélgica
SRN: BE-AR-000000040

Representante autorizado en Suiza
Qarad Suisse S.A.
World Trade Center
Avenue Gratta-Paille 2
1018 Lausanne
Suiza
CHRN: CHRN-AR-20002058

Reino Unido

Representante autorizado en el Reino Unido
Qarad UK Ltd
8 Northumberland Ave
Westminster, London WC2N 5BY
Reino Unido

Información de contacto
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Información para pedidos

1.	 Consumibles y accesorios

Los siguientes consumibles y accesorios se deben utilizar con el instrumento 
MagBinder® Fit24 y se pueden adquirir por separado:

Componente N.º de pieza

Cartucho de reactivos MB Fit24™, 5 ml 
(paquete de 200) 

PB07-5-200

Cartucho de reactivos MB Fit24™, 10 ml 
(paquete de 200) 

PB05-10-200

Tubos de elución (paquete de 200) PB01-2-200

Peine de puntas MB Fit24™ (paquete de 72) PB12-0-72

Kit de calificación MagBinder® Fit24 B1010-5-00

Visite el sitio web en www.omegabiotek.com o llame gratuitamente 
al 1-800-832-8896 para obtener más información.

Información para pedidos
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Historial de revisiones

Revisión Descripción

v1.0, octubre de 2023 Publicación inicial

v1.1, diciembre de 2023 Se ha actualizado la información para 
pedidos.

Se actualizaron los Capítulos 1.2 Garantía 
de fabricación.

Se actualizaron los Capítulos 5.2 Apartado 
de parámetros y función.
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Para obtener más soluciones de purificación,  
visite www.omegabiotek.com
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A Columnas giratorias Placas de sílice 
de 96 Pocillos

Microesferas 
magnéticas

Sangre/Plasma Plásmidos Células cultivadas Plantas y suelos

Materia fecalLimpieza de NGS Tejido FFPE




